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Abstract
	
	 Medical time series data forecasting with the Box-Jenkins method (the ARIMA model) 
is a quantitative prediction method with high accuracy and precision. It is a simple method, 
suitable for stationary time series data with constant mean and variance, the forecasters do 
not have to define a model before analyzing. During data analysis, the model is determined 
according to the time series’s structure.There are only four steps to implement: 1) Model 
Identification 2) Parameter Estimation 3) Diagnostic Checking and 4) Forecasting time 
series data.The IBM SPSS software also provides a model command wizard with Expert 
Modeler. The program will select the most appropriate model for the data to make it easier 
for the forecasters to select the model, but the forecasters should reconsider the statistical 
significance of selecting the most accurate model again. To obtain a model suitable for that 
time series data this creates the least forecast error for forecasting future time series data.
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ก า รพ ย า ก ร ณ์์ ข้้ อ มูู ล อ นุุ ก ร ม เ ว ล า
ทางการแพทย์์ด้้วยตััวแบบอารีีมา
วรีียา วงศ์์พานิิช

ภาควิิชาวิิสััญญีีวิิทยา คณะแพทยศาสตร์์ โรงพยาบาลรามาธิิบดีี มหาวิิทยาลััยมหิิดล กรุุงเทพมหานคร

บทคััดย่่อ

	 การพยากรณ์์ข้้อมููลอนุุกรมเวลาทางการแพทย์์ด้้วยวิิธีีบ็็อกซ์์เจนกินส์์ (ตััวแบบอารีีมา) เป็็นวิธีีการพยากรณ์์เชิิงปริมาณที่่�มีีความถููก
ต้้องและความแม่น่ยำำ�สูง เป็็นวิธีีที่่�ง่่าย เหมาะกับัข้้อมููลอนุุกรมเวลาที่่�มีีคุุณลักษณะคงที่่� ซึ่�งจะมีค่ี่าเฉลี่่�ยและความแปรปรวนคงที่่� ผู้้�พยากรณ์์
ไม่่ต้้องกำำ�หนดตััวแบบขึ้้�นมาก่่อนทำำ�การวิิเคราะห์์ ในระหว่่างการวิิเคราะห์์ข้้อมููล ตััวแบบจะถููกกำำ�หนดขึ้้�นมาตามโครงสร้างของชุุดอนุุกรม
เวลานั้้�น มีขั้้�นตอนการดำำ�เนิินการเพีียง 4 ขั้้�นตอน คือ 1) การกำำ�หนดตััวแบบของการพยากรณ์์ 2) การประมาณค่าพารามิิเตอร์์ 3) การ
ตรวจสอบความเหมาะสมของตััวแบบ และ 4) การพยากรณ์์ข้้อมููลอนุุกรมเวลา โปรแกรมสำำ�เร็็จรููป ไอบีีเอ็็ม เอสพีเอสเอส ยังมีีตััวช่่วยคำำ�
สั่่�งสร้างตััวแบบด้้วยผู้้�เชี่่�ยวชาญในการกำำ�หนดตััวแบบของการพยากรณ์์ โดยโปรแกรมจะเลืือกตััวแบบที่่�เหมาะสมกับข้้อมููลที่่�สุุดมาให้้ทำำ�ให้้
ผู้้�พยากรณ์์สามารถเลืือกตััวแบบได้้สะดวกขึ้้�น  แต่่ผู้้�พยากรณ์์ควรพิิจารณาเลืือกตััวแบบที่่�ได้้มาให้้มีีความถููกต้้องมากที่่�สุุดอย่่างมีีนััยสำำ�คัญ
ทางสถิติิอีีกครั้้�ง เพื่่�อจะได้้ตััวแบบที่่�เหมาะสมกับข้้อมููลอนุุกรมเวลานั้้�นๆ ทำำ�ให้้เกิิดความคลาดเคลื่่�อนในการพยากรณ์์น้้อยที่่�สุุดสำำ�หรัับการ
พยากรณ์์ข้้อมููลอนุุกรมเวลาในอนาคต

คำำ�สำำ�คััญ:  การพยากรณ์์; ข้้อมููลอนุุกรมเวลา; ตััวแบบอารีีมา;โปรแกรมไอบีีเอ็็ม เอสพีเอสเอส; วิธีีบ็็อกซ์์เจนกินส์์ 
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บทนำำ�
	 ข้้อมููลอนุุกรมเวลาทางการแพทย์์มีีลัักษณะที่่�มีีความหลากหลาย 
เช่่นโรคที่่�เกิิดขึ้้�นตามฤดููกาล หรืือโรคที่่�เกิิดขึ้้�นตลอดทั้้�งปีี การเลืือกใช้้เทคนิิค
การพยากรณ์์ที่่�มีีประสิิทธิิภาพจึึงเป็็นสิ่่�งสำำ�คัญที่่�จะได้้ตััวแบบที่่�เหมาะสม
กัับข้้อมููลนั้้�นๆ มาพยากรณ์์ให้้มีีความคลาดเคลื่่�อนน้อยที่่�สุุด เพื่่�อให้้ทราบ
จำำ�นวนผู้้�ป่วยในอนาคตที่่�เกิิดขึ้้�นจากโรคและภััยสุุขภาพที่่�ใกล้้เคีียงกัับ
โอกาสที่่�จะเกิิดขึ้้�นจริิงในอนาคต  ในการเตรียมการป้้องกัันล่วงหน้้าให้้มีี
การเกิิดน้อยลงหรืือไม่่เกิิดขึ้้�นเลย ลดการสููญเสีียทั้้�งชีีวิิต  ทรััพย์์สิินและ
ทรััพยากรต่่างๆ มีหน่่วยงานราชการได้้ทำำ�รายงานข้้อมููลอนุุกรมเวลา เช่่น 
กรมควบคุมโรค กระทรวงสาธารณสุข มีการพยากรณ์์โรค 7 โรคที่่�สำำ�คัญ 
ได้้แก่่ โรคไข้้เลืือดออก โรคไข้้หวััดใหญ่่ โรคมืือ เท้้า ปาก โรคตาแดง โรค
อาหารเป็็นพิษ โรคไข้้ฉี่่�หนูู และโรคเมลิออยโดสิส ด้้านภัยสุุขภาพที่่�สำำ�คัญ

มีี 2 เรื่่�อง ได้้แก่่ การบาดเจ็็บจากอุุบััติิเหตุุจราจรในช่่วงเทศกาลปีีใหม่่
และสงกรานต์ และการป่่วยด้้วยโรคทางเดิินหายใจในช่วงปััญหาหมอก
ควัันภาคเหนืือตอนบน1 และสำำ�นักระบาด กรุุงเทพมหานคร ได้้พยากรณ์์
จำำ�นวนผู้้�ป่วยที่่�เป็็นโรคที่่�ต้้องเฝ้้าระวัังทางระบาดวิทยา ได้้แก่่ โรคอุุจจาระ
ร่่วงเฉีียบพลััน โรคไข้้เลืือดออก โรคไข้้หวััดใหญ่ ่โรคตาแดง โรคปอดอักเสบ 
โรคมืือเท้้าและปาก โรคสุุกใส  โรคอาหารเป็็นพิษ โรคแผลในปาก โรค
วััณโรคปอด เป็็นต้น บทความนี้้�ได้้นำำ�ข้้อมููลอนุุกรมเวลาของการป่่วยด้้วย
โรคอาหารเป็็นพิษ (food poisoning) ของจัังหวััดกรุุงเทพมหานคร มาเป็็น
ตััวอย่่างในการวิเิคราะห์์ด้้วยเทคนิคิการพยากรณ์์ เนื่่�องจากเล็ง็เห็็นว่า โรคนี้้�
เป็็นโรคที่่�ใกล้้ตััวเพราะเกี่่�ยวข้้องกัับอาหารการกิินในชีวิิตประจำำ�วัน รวมทั้้�ง
กรมควบคุมโรค กระทรวงสาธารณสุขุและสำำ�นักระบาด กรุุงเทพมหานคร 
ให้้ความสำำ�คัญจััดเป็็นโรคที่่�ต้้องเฝ้้าระวัังทางระบาดวิทยาด้้วย
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การพยากรณ์์โดยวิิ ธีีการวิิ เคราะห์์อนุุกรมเวลามีีสมมติฐานว่า
ประวััติิศาสตร์ย่่อมซ้ำำ��รอย ดั งนั้้�นจึึงสามารถใช้้ข้้อมููลในอดีีตเฉพาะเรื่่�อง
ที่่�ต้้องการคาดคะเนมาใช้้พยากรณ์์สิ่่�งนั้้�นในอนาคต ซึ่่�งถ้้าต้้องการพยากรณ์์
สิ่่�งใดก็ต้้องใช้้ข้้อมููลในอดีีตของสิ่่�งนั้้�นเท่่านั้้�นมาใช้้ในการพยากรณ์์โดยไม่่
คำำ�นึึงถึึงตััวแปรอื่่�นๆ ในปััจจุุบัันนี้้� การพยากรณ์์เชิิงปริิมาณที่่�ใช้้กัันอยู่่�มี
ด้้วยกััน 8 วิธีี2  คือ 
	 1. วิธีีทำำ�ให้้เรีียบเอ็็กโปเนนเชีียลอย่่างง่่าย  
	 2. วิธีีของโฮลท์์  
	 3. วิธีีของวิินเตอร์์  
	 4. วิธีีแยกส่่วนประกอบ  
	 5. วิธีีของบ็็อกซ์์เจนกินส์์  
	 6. วิธีีวิิเคราะห์์การถดถอยแบบพหุุ 
	 7. วิธีีวิิเคราะห์์เชิิงเศรษฐมิิติิ และ  
	 8. วิธีีวิิเคราะห์ข์องบ็็อกซ์์เจนกินิส์์แบบพหุ ุ มีโปรแกรมสำำ�เร็็จรููป
มากมายในการช่่วยวิิเคราะห์์สถิติิพยากรณ์์ เช่่น MINITAB, SPSS/PC+, 
IBM SPSS, SAS, MedCalc เป็็นต้น 
	 ในปี ค.ศ. 1972 George E.P. Box และ Gwilym M. Jenkins3 

ได้้พััฒนาวิิธีีการวิิเคราะห์์ข้้อมููลอนุุกรมเวลาขึ้้�นโดยใช้้ ตััวแบบจำำ�ลอง 
ARIMA (Auto Regressive Intergrated Moving Average) หรืือ
วิิธีีบ็็อกซ์์เจนกินส์์ (Box-Jenkins mothod) เป็็นการนำำ� Regression 
technique ม าประยุุกต์์ใช้้กัับข้้อมููลอนุุกรมเวลา ต้ องมีีการตรวจสอบ
ข้้อมููลอนุุกรมเวลา ว่ามีีคุุณลักษณะคงที่่�หรืือไม่่ก่่อนดำำ�เนิินการวิิเคราะห์์ 
	 สำำ�หรัับการพยากรณ์์โดยวิิธีีบ็็อกซ์์เจนกินส์เป็็นเทคนิิค
การพยากรณ์์ที่่�มีีจุุดเด่่น คืือ 
1. เป็็นวิธีีให้้ค่่าพยากรณ์์ไปข้้างหน้้าที่่�ดีีทั้้�งในช่่วงระยะสั้้�น  ระยะกลาง 
และระยะยาว2, 7 

2. เหมาะกัับกรณีีที่่�ใช้้วิิธีีการพยากรณ์์อื่่�นไม่่ได้้ผล ข้้อมููลอนุุกรมเวลาที่่�มีี
คุุณลักษณะคงที่่�
3. เป็็นวิธีีที่่�ไม่่มีีการกำำ�หนดตััวแบบตายตััวขึ้้�นก่อนทำำ�การวิิเคราะห์์ ใน
ระหว่่างการวิิเคราะห์์ตััวแบบจะถููกกำำ�หนดขึ้้�นมาเองตามโครงสร้างของ
อนุุกรมเวลานั้้�นๆ ทำำ�ให้้ตััวแบบที่่�ได้้มีีความคลาดเคลื่่�อนต่ำำ�� 
4. เป็็นวิธีีพยากรณ์์เชิิงปริมาณวิธีีหน่ึ่�งที่่�มีีความถููกต้้องและแม่่นยำำ�สูงสุุด 
สำำ�หรัับ 2-3 ค่าแรกของการพยากรณ์์2,3,6,7

5. เป็็นวิธีีที่่�ง่่ายต่่อการเข้้าใจ แม้้ผู้้�พยากรณ์์จะขาดประสบการณ์์ แต่่มีี
ความเข้้าใจเรื่่�องกราฟอััตสหสััมพันธ์ก็็อาจได้้ตััวแบบในการพยากรณ์์ที่่�ดีี
ได้้โดยใช้้โปรแกรมสำำ�เร็็จรููป5 

จุุดด้้อย  คืือ
1. จำำ�นวนข้้อมููลย้้อนหลัังที่่�นำำ�มาวิิเคราะห์์อย่่างน้้อย 50 ค่า แต่่โดยมาก
แล้้วจะใช้้ประมาณ 100 ค่าเป็็นต้นไป การเตรียมข้้อมููล ยิ่่�งมีีข้้อมููลมาก
เท่่าไหร่่ ยิ่่ �งมีีความแม่่นยำำ�ในการพยากรณ์์มากเท่่านั้้�น สำ ำ�หรัับข้้อมููลที่่�มีี
อิิทธิิพลของฤดููกาลต้้องใช้้จำำ�นวนข้้อมููลย้อ้นหลััง 5 รอบของฤดููกาล (5*S)  
ซ่ึ่�งต้้องมีีค่่าเฉลี่่�ยคงที่่� ฤดููกาลคงที่่� มีความแปรปรวนเล็็กน้้อย2,7 

2. ไม่่เหมาะกัับข้้อมููลอนุุกรมเวลาที่่�มีีรููปแบบของอิทิธิิพลแนวโน้้ม วัฏจัักร
และฤดููกาลที่่�เด่่นชัด ควรเลืือกใช้้เทคนิิคการพยากรณ์์วิิธีีอื่่�นให้้เหมาะสม

กัับข้้อมููลอนุุกรมเวลานั้้�นๆ เพื่่�อจะให้้มีีความคลาดเคลื่่�อนน้อยที่่�สุุด
3. การคำำ�นวณด้้วยตนเองด้้วยมืือมีีความยุ่่�งยาก ซั บซ้อน ต้ องใช้้
คอมพิวเตอร์์เพื่่�อเพิ่่�มประสิิทธิิภาพการทำำ�งานให้้ง่่ายขึ้้�น

นิิยามคำำ�ศััพท์์
      นิยามศัพท์์เฉพาะมีีดัังนี้้�
ข้้อมููลอนุุกรมเวลา คือ ข้้อมููลที่่�มีีการเปลี่่�ยนแปลงเมื่่�อเวลาเปลี่่�ยนไป มัก
จััดเก็็บเป็็นข้้อมููลตามคาบเวลาที่่�แน่่นอน เช่่น รายปีี คร่ึ่�งปีี รายไตรมาส 
รายเดืือน รายวััน เป็็นต้น
ข้้อมููลอนุุกรมเวลา ป ระกอบด้้วยองค์์ประกอบ  4 ส่ วน4 คื อ แนวโน้้ม 
(Trend: T), ฤดููกาล (Seasonal: S), วัฏจัักร (Cycle: C) และเหตุุการณ์์
ที่่�ผิิดปกติิหรืือเหตุุการณ์์ความไม่่แน่่นอน (Irregular: I) 
ข้้อมููลอนุุกรมเวลาทางการแพทย์์ คือ ข้้อมููลเชิิงปริมาณทางการแพทย์์
สาธารณสุขมีการเก็็บรวบรวมตามคาบของเวลาอย่่างต่่อเนื่่�อง หรืือข้้อมููล
เชิิงปริมาณทางการแพทย์์สาธารณสุขที่่�ขึ้้�นอยู่่�กับปัจจััยเวลา
ARIMA model คือ ตััวแบบ ARIMA (p, d, q) มีส่่วนประกอบที่่�สำำ�คัญ 3 
ส่่วน4 ได้้แก่่ AutoRegressive AR: (p), Intergrated I: (d) และ Moving 
Average MA: (q)
SARIMA model คื อ ตััวแบบอนุุกรมเวลาที่่�มีีอิิทธิิพลฤดููกาลเข้้ามา
เกี่่�ยวข้้อง พิจารณาพารามิิเตอร์์ Seasonal I(D), Seasonal AR(P) และ 
Seasonal MA(Q) เข้้าไปในตััวแบบ ARIMA(p,d,q)x(P,D,Q)S 

การพยากรณ์์ คือ การประมาณการ หรืือ การคาดคะเนว่าอะไรจะเกิิด
ขึ้้�นช่วงเวลาในอนาคต
วิิธีีการพยากรณ์์ แบ่่งตามลักษณะข้้อมููล มี 2 ประเภท5 คือ  
1. การพยากรณ์์เชิิงปริมาณ อาศััยข้้อมููลในอดีีตเป็็นหลัักในการคาดคะเน
และประมาณการสิ่่�งใดที่่�จะเกิิดในช่วงเวลาในอนาคต
2. การพยากรณ์์เชิิงคุุณภาพ ไม่่อาศััยข้้อมููลในอดีีตเป็็นหลััก แต่่ใช้้ความ
รู้้�สึึกสามััญสำำ�นึึกและประสบการณ์์ต่่างๆ ที่่�ผ่่านมา

แบ่่งตามระยะเวลาในการพยากรณ์์ มี 4 ระยะ6 คือ 
1. การพยากรณ์์ 1 หน่่วยเวลาล่่วงหน้้า (intermediate-term fore-
casting)
2. การพยากรณ์์ช่่วงสั้้�น (short-term forecasting)
3. การพยากรณ์์ช่่วงกลาง (middle –term forecasting) 
4. การพยากรณ์์ระยะยาว (long-term forecasting)

ข้้อตกลงเบื้้�องต้้นของการวิิเคราะห์์ด้้วยวิิธีีบ็็อกเจนกินส์
	 การทดสอบอนุุกรมเวลา เป็็นสิ่่�งที่่�ควรกระทำำ�ก่อนที่่�จะนำำ�ข้้อมููล
อนุุกรมเวลามาใช้้ในการวิิเคราะห์์ โดยเฉพาะเงื่่�อนไขความคงที่่�ของอนุุกรม
เวลา (stationary) ซึ่�งเป็็นเงื่่�อนไขที่่�สำำ�คัญในการนำำ�ข้้อมููลอนุุกรมเวลามาใช้้ 
ดัังนั้้�นถ้าหากอนุุกรมเวลาที่่�นำำ�มาใช้้ไม่่คงที่่�จะต้้องทำำ�ให้้อนุุกรมเวลา ดังักล่่าว
คงที่่�ก่่อน
	 ข้้อมููลที่่�มีีลัักษณะคงที่่� (stationary) หมายถึึง ข้้อมููลอนุุกรม
เวลาที่่�มีีค่่าเฉลี่่�ย (mean) และ ความแปรปรวน (variance) เท่่ากัันตลอด



41

Siriraj Medical Bulletin

41

Siriraj Medical Bulletin

ระยะเวลาที่่�ศึึกษา และข้้อมููลไม่่มีีการเปลี่่�ยนแปลงตามฤดููกาล ส่วนข้้อมููล
ที่่�มีีลัักษณะไม่่คงที่่� (non-stationary) หมายถึึงข้้อมููลอนุุกรมที่่�มีีค่่าเฉลี่่�ย 
(mean) และความแปรปรวน  (variance) ไม่่เท่่ากัันตลอดระยะเวลาที่่�
ศึึกษา หรืือข้้อมููลแสดงการเปลี่่�ยนแปลงตามฤดููกาล

การปรัับข้้อมููลให้้เป็็น Stationary2,3,5

1. ถ้าอนุุกรมเวลา (Y
t
) มีแนวโน้้ม ต้องปรับให้้เป็็นอนุุกรมเวลาใหม่่ที่่�ไม่่มีี

แนวโน้้ม โดยการใช้้วิิธีี Regular Differencing (ใช้้สััญลัักษณ์์ d) กรณีีที่่�
หาความแตกต่่างแค่่ลำำ�ดับเดีียว (d = 1) 
2. ถ้ าอนุุกรมเวลา (Y

t
) มีความเป็็นฤดููกาล ต้องปรับให้้เป็็นอนุุกรมเวลา

ใหม่่ที่่�ไม่่มีีฤดููกาล โดยการใช้้วิิธีี Seasonal Differencing (ใช้้สััญลัักษณ์์ 
D) กรณีีที่่�หาความแตกต่่างของฤดููกาลแค่่ลำำ�ดับเดีียว (D = 1) 
3. ถ้าอนุุกรมเวลา(Y

t
) มีแนวโน้้มและมีีความเป็็นฤดููกาล ต้องปรับให้้เป็็น

อนุุกรมเวลาใหม่่ที่่�ไม่่มีีทั้้�งแนวโน้้มและฤดููกาล โดยการใช้้วิิธีี Regular 
and Seasonal Differencing กรณีีที่่�หาความแตกต่่างของทั้้�งแนวโน้้ม
และฤดููกาลแค่่ลำำ�ดับเดีียว (d = 1 และ D = 1)
4. กรณีีที่่�ความแปรปรวนของอนุุกรมเวลาไม่่คงที่่� (Var(y

t
) ไม่่คงที่่�ในแต่่ละ

เวลา t) จะต้อ้งการปรับัอนุุกรมเวลา (Y
t
) ให้้เป็็นอนุุกรมเวลาใหม่ ่โดยการ

ทำำ� Logarithmic transformation  หรืือ  Square root transformation

การตรวจสอบความเหมาะสมของรููปแบบหรืือสมการการ
พยากรณ์์ สามารถศึึกษาเพิ่่�มเติิมได้้จาก (Box et al., 1994)3

	 อนุุกรมเวลา (Yt) ที่่�ศึึกษาครั้้�งนี้้�เป็็นอนุุกรมเวลาตััวแบบ ARIMA 
(p,d,q) (P,D,Q)S มีรููปแบบคือ
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โดยที่่�
	 Y

t
 คือ ค่่าสัังเกตของอนุุกรมเวลา ณ เวลา t (ที่่�เป็็นสเตชันนารีี)

	 ϕ, Φ, ϴ, Ψ คือ พารามิิเตอร์์ในตััวแบบที่่�ต้้องการประมาณค่า
	 B คือ ตััวดำำ�เนิินการถอยหลัังเวลา นั่่�นคือ B mY

t
= Y

t-m 

	 d คื อ จำ ำ�นวนครั้้�งของการทำำ�ผลต่่างแบบมีแนวโน้้มเพื่่�อให้้
อนุุกรมเวลา (Y

t
) อยู่่�ในสภาวะคงที่่�

	 D คื อ จำ ำ�นวนครั้้�งของการทำำ�ผลต่่างแบบมีฤดููกาลเพื่่�อให้้
อนุุกรมเวลา (Y

t
) อยู่่�ในสภาวะคงที่่�

	 p และ P คือ ลำำ�ดับของตััวแบบการถดถอยภายในฤดููกาล (p) 
และระหว่่างฤดููกาล (P)
	 q และ Q คื อ ลำ ำ�ดับของตััวแบบค่่าเฉลี่่�ยเคลื่่�อนที่่�ภายใน
ฤดููกาล (q) และระหว่่างฤดููกาล (Q) 
	 ε

t
 คื อ ความคลาดเคลื่่�อนสุ่่�มที่่�มีีการแจกแจงแบบปกติิ ณ 

เวลา t ซึ่�งมีีค่่าเฉลี่่�ยเท่่ากัับศูนย์์และความแปรปรวนคงที่่� เท่่ากัับ σ2
ε 

และเป็็นอิสระต่่อกััน
	 S   คือ จำำ�นวนฤดููกาลต่่อปีี ในที่่�นี้้� S = 12

การวิินิิจฉััยตัวแบบการพยากรณ์์โดยวิิธีีบ็็อกซ์์เจนกินส์5,6

	 การประเมิินค่าความแม่่นยำำ�ของการพยากรณ์์ ควรเลืือกตรวจ
มากกว่่า 2 รายการ สำ ำ�หรัับบทความนี้้�ใช้้ค่่าสถิติิ เกณฑ์์รากที่่�สองของ
ความคลาดเคลื่่�อนกำำ�ลังสองเฉลี่่�ย ค่ าคลาดเคลื่่�อนสัมบูรณ์์เฉลี่่�ย และ 
เปอร์์เซ็็นต์ของความคลาดเคลื่่�อนสัมบูรณ์์เฉลี่่�ย เพื่่�อทดสอบความแม่่นยำำ� 
ของผลการพยากรณ์์ ค่า Error ยิ่่�งต่ำำ�� ยิ่่�งดีี
	 เกณฑ์์รากที่่�สองของความคลาดเคลื่่�อนกำำ�ลังสองเฉลี่่�ย RMSE 
(Root Mean Squared Error) ใช้้พิิจารณาหาจุุดเหมาะสมสำำ�หรัับรูป
แบบหรืือสมการการพยากรณ์์ (optimal forecasting model) ด้้วย
การประมาณค่าพารามิิเตอร์์ของสมการที่่�ทำำ�ให้้ค่่า RMSE มีค่่าน้้อยที่่�สุุด,  
ค่่าคลาดเคลื่่�อนสัมบูรณ์์เฉลี่่�ย MAE (Mean Absolute Error) มี ค่่ายิ่่�ง
ต่ำำ��ยิ่่�งดีี ถ้าเท่่ากัับ 0 แปลว่่าโมเดลทำำ�นายค่่า Y ได้้ถููกต้้อง 100% และ
เปอร์์เซ็็นต์ของความคลาดเคลื่่�อนสัมบูรณ์์เฉลี่่�ย MAPE (Mean Absolute 
Percentage Error) MAPE < 10% ถือว่่าการพยากรณ์์นั้้�นมีความแม่่นยำำ�
มาก, MAPE 10 - 20% ถือว่่าการพยากรณ์์นั้้�นดี, MAPE 20 - 50% ถือว่่า
การพยากรณ์์นั้้�นพอใช้้ได้้ และ MAPE > 50% ถือว่่าการพยากรณ์์นั้้�นไม่่มีี
ความแม่่นยำำ�  

ขั้้�นตอนของวิิธีีบ็็อกเจนกินส์2

	 การวิิเคราะห์์อนุุกรมเวลาจะต้้องเขีียนกราฟข้้อมููลชุุดนั้้�นก่่อน
เสมอ การศึึกษาความเคลื่่�อนไหวของอนุุกรมเวลาเพื่่�อพิิจารณาเบื้้�อง
ต้้นว่่าข้้อมููลอนุุกรมนั้้�นมีลัักษณะแบบใด ทำ ำ�การทดสอบองค์์ประกอบ
แนวโน้้มและความแปรผัันตามฤดููกาล ในกรณีีที่่�ข้้อมููลอนุุกรมเวลาที่่�ใช้้
ในการวิิเคราะห์์มีีคุุณสมบัติิไม่่คงที่่� (Non-stationary) จะต้้องทำำ�การ
แปลงข้้อมููลอนุุกรมเวลาดัังกล่่าวให้้มีีคุุณสมบัติิคงที่่�ก่่อน 

	 ขั้้�นตอนที่่� 1 การกำำ�หนดตััวแบบของการพยากรณ์์ (model 
Identification) ซึ่ �งเป็็นขั้้�นตอนการพิิจารณาว่่าตััวแบบใดเหมาะสม
ที่่�สุุดกับข้้อมููลที่่�นำำ�มาวิิเคราะห์์ โดยพิิจารณาจากกราฟอััตสหสััมพันธ์์ 
(Auto Correlation Function: ACF) และกราฟอััตสหสััมพันธ์์บางส่่วน 
(Partial Auto Correlation Function: PACF) ระบุุลำำ�ดับ  AR(p) 
และ MA(q) โดยพิิจารณา AR(p) จากกราฟ PACF และ MA(q) จาก
กราฟ ACF ภายในฤดููกาล ระบุุลำำ�ดับ Seasonal AR(P) และ Seasonal 
MA(Q) สำำ�หรัับ Seasonal AR(P) พิจารณาจากกราฟ PACF และ Sea-
sonal MA(Q) พิจารณาจากกราฟ ACF  ระหว่่างฤดููกาลโดยพิิจารณา 
Lag ที่่� 12, 24  ตามรูปแบบที่่�บ็็อกซ์์เจนกินส์์กำำ�หนดไว้้  การพิิจารณา 
ระบุุลำำ�ดับ AR(p), MA(q), SAR(P) และ SMA(Q) ต้้องทำำ�การทดสอบ
ว่่า Lag ใดที่่�มีีค่่าแตกต่่างจาก 0 อย่่างมีีนััยสำำ�คัญทางสถิติิจึึงจะสามารถ
ระบุุลำำ�ดับได้้อย่่างถููกต้้อง
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ตารางที่่� 1  แสดงลัักษณะกราฟ ACF และ PACF เพื่่�อระบุุลำำ�ดัับ 
AR(p), MA(q), SAR(P) และ SMA(Q)

ตััวแบบ
ลัักษณะกราฟ 

ACF
ลัักษณะกราฟ 

PACF

ARIMA(1,0,1)  
คืือ AR(1), MA(1)

Lag 1 ≠ 0 หลัังจาก 
Lag 1 มีค่่า = 0

Lag 1 ≠ 0 หลัังจาก 
Lag 1 มีค่่า = 0

ARIMA(1,0,0)  
คืือ AR(1), MA(0)

ลดลงเข้้าใกล้้ 0 อย่่าง
รวดเร็็ว

Lag 1 ≠ 0 หลัังจาก 
Lag 1 มีค่่า = 0

ARIMA(0,0,1)  
คืือ AR(0), MA(1)

Lag 1 ≠ 0 หลัังจาก 
Lag 1 มีค่่า = 0

ลดลงเข้้าใกล้้ 0 อย่่าง
รวดเร็็ว

SAR(1)12 
*กรณีีฤดููกาลเป็็น
รายเดืือน S=12

Lag 12, Lag 24,….
ลดลงเข้้าใกล้้ 0 อย่่าง
รวดเร็็ว

Lag 12 ≠ 0 หลัังจาก 
Lag 12 มีค่่า = 0 
(คืือ Lag 24, Lag 36, 
Lag 48….)

SMA(1)12 

*กรณีีฤดููกาลเป็็น
รายเดืือน S=12

Lag 12 ≠ 0 หลัังจาก 
Lag 12 มีค่่า = 0 
(คืือ Lag 24, Lag 36, 
Lag 48….)

Lag 12, Lag 24,….
ลดลงเข้้าใกล้้ 0 อย่่าง
รวดเร็็ว

SARIMA(1,0,1)12 

*กรณีีฤดููกาลเป็็น
รายเดืือน S=12

Lag 12 ≠ 0 หลัังจาก 
Lag 12 มีค่่า = 0 
(คืือ Lag 24, Lag 36, 
Lag 48….)

Lag 12 ≠ 0 หลัังจาก 
Lag 12 มีค่่า = 0 
(คืือ Lag 24, Lag 36, 
Lag 48….)

ที่่�มา:  วรีียา วงศ์์พานิิช

	ขั้้ �นตอนที่่� 2 การประมาณค่าพารามิิเตอร์์ (parameter esti-
mation) ข องตััวแบบที่่�กำำ�หนดด้้วยวิิธีีควรจะเป็็นค่าสููงสุุด  (maximum 
likelihood) ตรวจสอบตััวแบบจำำ�ลอง (ปััญหา autocorrelation) ด้้วย
วิิธีี Ljung-Box Q-statistics ดูค่่า Ljung-Box test (ถ้้า p value > 0.05 
ให้้ถืือว่่า error มีความเป็็นอิสระกััน) 
	ขั้้ �นตอนที่่� 3 การตรวจสอบความเหมาะสมของตััวแบบ (diag-
nostic checking) อนุุกรมเวลาหน่ึ่�งๆ อาจมีีมากกว่่า 1 ตััวแบบ ดังนั้้�น 
ควรเลือืกตััวแบบที่่�เหมาะสมที่่�สุุด จะต้้องมีีการตรวจสอบความเหมาะสม
แต่่ถ้้าหากตััวแบบที่่�กำำ�หนดไม่เ่หมาะสมจะต้อ้งมีีการกำำ�หนดตััวแบบในขั้้�น
ตอนที่่� 1 ใหม่่ 
	ขั้้ �นตอนที่่� 4 การพยากรณ์์ (forecasting) พยากรณ์์ออกไป
ข้้างหน้้าจำำ�นวน  n ช่ วงเวลา สำ ำ�หรัับโปรแกรม  IBM SPSS กระทำำ�ด้้วย
วิิธีี backcasting ก่ อนที่่�จะนำำ�ค่าประมาณพารามิิเตอร์์มาสร้างสมการ
การพยากรณ์์และทำำ�การเปรียบเทีียบประสิิทธิิภาพ (ความแม่่นยำำ�) ของ
ตััวแบบพยากรณ์์ (forecast evaluation statistics) โดยใช้้สถิติิวััด
ความคลาดเคลื่่�อน เช่่น ME, RMSE, MAE MPE และ MAPE 

วััตถุุประสงค์์
	 วััตถุประสงค์์ของบทความนี้้� เพื่่� อนำำ� เสนอขั้้�นตอนการ
วิิเคราะห์์ข้้อมููลอนุุกรมเวลาทางการแพทย์์ด้้วยวิิธีีบ็็อกซ์์เจนกินส์์ 
(Box-Jenkins method) เพื่่�อหาตััวแบบอารีีมา (ARIMA model) 
ด้้วยโปรแกรมสำำ�เร็็จรููป  IBM SPSS โดยการพยากรณ์์ข้้อมููลอนุุกรม
เวลาการป่่วยด้้วยโรคอาหารเป็็นพิษ (Food poisoning) ของจัังหวััด
กรุุงเทพมหานคร

ตััวอย่่างการพยากรณ์์  
	 บทความนี้้�ใช้้ข้้อมููลอนุุกรมเวลาของการป่่วยด้้วยโรคอาหาร
เป็็นพิษ (food poisoning) ของจัังหวััดกรุุงเทพมหานคร โดยใช้้ข้้อมููล
จากเว็็ปไซต์์ของระบบฐานข้้อมููลแบบรายงาน  506 ข องกรมควบคุม
โรค กระทรวงสาธารณสุุข ตั้้�งแต่่เดืือนมกราคม พ.ศ. 2546 ถึึง ธันวาคม 
พ.ศ. 2562 จำำ�นวน 204 ค่่า ได้้แบ่่งข้้อมููลออกเป็็น 2 ชุด ชุดที่่� 1 ข้้อมููล
ตั้้�งแต่่เดืือนมกราคม พ.ศ. 2546 ถึึงธัันวาคม พ.ศ. 2561 จำำ�นวน 192 
ค่่า เพื่่�อใช้้ในการหา model ที่่�เหมาะสม ชุดที่่� 2 ข้้อมููลเดืือนมกราคม 
พ.ศ.2562 ถึึง ธันวาคม พ.ศ. 2562 จำำ�นวน 12 ค่า่ นำำ�มาทำำ�การพยากรณ์์
ค่่าที่่�ตััดออกไป เรีียกว่่า วิธีี backcasting หาค่่าพยากรณ์์ย้้อนหลัังเพื่่�อ
การวิินิิจฉััยตััวแบบตรวจสอบความแม่่นยำำ�ของตััวแบบ 
	 เริ่่�มต้้นด้้วย การเตรีียมข้้อมููล เปิิด Data file.sav ซึ่่�งประกอบ
ด้้วย Food Poisoning (case) ข้้อมููลตั้้�งแต่่เดืือนมกราคม พ.ศ. 2546 
ถึึงธัันวาคม พ.ศ. 2561 จำำ�นวน 192 ค่่า สำำ�หรัับสร้้างตััวแบบอารีีมา 
เราต้้องกำำ�หนดให้้โปรแกรมรู้้�จักข้้อมููลอนุุกรมเวลาก่่อนด้้วยการคลิิก
ที่่�เมนู  Data > Define dates > เลืือกรููปแบบเวลาที่่�ตรงกัับข้้อมููล
ของเรา (เช่่น ถ้้าเป็็นข้้อมููลรายเดืือน ก็็คืือ Years, months) และระบุุ
เวลาที่่�เริ่่�มต้้น เช่่น Year = 2546, month = 1 click OK (ภาพที่่� 1A) 
จากนั้้�นจะสัังเกตเห็็นว่่ามีีตััวแปรใหม่่เกิิดขึ้้�นในข้้อมููลของเรา (YEAR_, 
MONTH_, DATE_)  ดัง (ภาพที่่� 1B) 

	ขั้้ �นตอนที่่� 1 การกำำ�หนดตััวแบบของการพยากรณ์์ 
(Model Identification) ก่่อนอื่่�นให้้ทำำ�การตรวจสอบว่า่ข้้อมููลอนุุกรม
เวลามีีคุุณสมบัติิคงที่่�แล้้วหรืือไม่่ โดยจะต้้องเขีียนกราฟของข้้อมููลชุุดนั้้�น
ก่่อนเสมอ ต ามหลัักการแล้้วการสรุปว่าอนุุกรมเวลานั้้�นมีองค์์ประกอบที่่�
เป็็นแนวโน้้มหรืือฤดููกาลหรืือไม่่นั้้�นจะต้้องพิิจารณาจากกราฟ ACF และ 
PACF ตามเงื่่�อนไขที่่�ชี้้�แจงไว้้ในขั้้�นตอนที่่� 1 เพื่่�อพิิจารณาความเคลื่่�อนไหว
ของอนุุกรมเวลาว่่ามีีองค์์ประกอบของอนุุกรมเวลาเป็็นอะไรบ้้าง หรืือ
ลัักษณะของอนุุกรมเวลามีีค่่าเฉลี่่�ยคงที่่�หรืือไม่่ โดยใช้้โปรแกรม IBM SPSS 
สร้างกราฟ มีคำำ�สั่่�งดัังนี้้�  
1. โดยคลิิก Analyze > Forecasting > Sequence Charts
2. ในช่อง Variables ให้้เลืือกตััวแปรที่่�เราต้้องการพยากรณ์์ เช่่น Food 
Poisoning (case)
3.  ในช่อง Time Axis Labels ให้้เลืือกตััวแปร Date. Format: “MMM” 
4.  กด OK เพื่่�อดููลัักษณะของกราฟ 
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การแปลงข้้อมููลอนุุกรมเวลา ในกรณีีที่่�ข้้อมููลอนุุกรมเวลาที่่�ใช้้ในการ
วิิเคราะห์์คุุณสมบัติิไม่่คงที่่� (Non-stationary) จะต้้องทำำ�การแปลงข้้อมููล
อนุุกรมเวลาดัังกล่่าวให้้มีีคุุณสมบัติิคงที่่�ก่่อน
	 1.1 โดยการคลิิกเมนู Analyze > Forecasting > Create 
models ดัง (ภาพที่่� 2A)
	 1.2 Variable tab (ภาพที่่� 2D)
	 	 ในช่อง Dependent variable ให้้เลืือกตััวแปรที่่�
ต้้องการวิิเคราะห์์ เช่่น Food Poisoning (case)
	 	 ในช่อง Independent variable ให้้เลืือกตััวแปรที่่�
ต้้องการวิิเคราะห์์ เช่่น MONTH, period 12_MONTH_1
	 	 ในช่อง Method ให้้เลืือกวิิธีีการวิิเคราะห์์ที่่�จะใช้้เป็็น 
ARIMA คลิิก Criteria dialog box ไปสู่่� Model tab
	 	 ใน ARIMA Criteria dialog box ช่อง ARIMA or-
der ให้้ปล่อยให้้ค่่า AR และ MA เป็็น 0 ไว้้ก่่อน แต่่ให้้เลืือก Difference 
nonseasonal = 1 และ Transformation ในรูปแบบที่่�จะทำำ�ให้้ข้้อมููล
เป็็น Stationary โดยทั่่�วไปมักไม่่ทำำ�การหาผลต่่าง (Difference) มากเกิิน 
2 ครั้้�ง ข้้อมููลอนุุกรมเวลาก็็จะเป็็น Stationary แล้้ว 
	 1.3 Model tab (ภาพที่่� 2B) กำำ�หนด p=0, d=1, q=0 และ 
P=0, D=0, Q=0  
	 การ difference 1 ครั้้�ง เพื่่�อให้้ดููการเปลี่่�ยนแปลงกราฟให้้แอมพิ
จููดใกล้้เคีียงกััน ทำำ�ให้้ความแม่่นยำำ� ARIMA ดีขึ้้�น การ difference 1 ครั้้�ง 
เป็็นการจััดการข้้อมููลให้้น้้อยที่่�สุุด,  d เป็็นการ difference TREND,  D 
เป็็นการ difference SEASONAL  ให้้ค่่าแอมพิจููดของกราฟคงที่่�
	 1.4 Plots tab (ภาพที่่� 2C)
	 	 ในช่อง Plots for individual Models ให้้เลืือก 
Residual ACF และ Residual PACF กด OK เพื่่�อดููลัักษณะ
กราฟ ACF และ PACF หาค่่าลำำ�ดับ AR (p), MA (q), Seasonal AR (P) 
และ Seasonal MA(Q) ที่่�เหมาะสมดัง (ภาพที่่� 2E)
	 จากกราฟ ACF และ PACF ดังภาพ ที่่� 3A พบว่า อนุุกรมเวลา
ยัังไม่่คงที่่� ดั งนั้้�นผู้้�นิพนธ์จึึงแปลงข้้อมููลด้้วยผลต่่างแนวโน้้มลำำ�ดับ ที่่ � 1 
(d=1, D=0, S=12) ได้้กราฟ ACF และ PACF ของอนุุกรมเวลาที่่�แปลง
ข้้อมููลแล้้ว แสดงดังัภาพ ที่่� 3B ซึ่�งพบว่า อนุุกรมเวลามีลัีักษณะคงที่่� และใน
ภาพที่่� 3C แสดงรายละเอีียดค่าสััมประสิิทธิ์์�อััตสหสััมพันธ์และสััมประสิิทธิ์์�
อััตสหสััมพันธ์บางส่่วนของค่่าคลาดเคลื่่�อนตกอยู่่�ในขอบเขต ความเชื่่�อมั่่�น
ร้้อยละ 95  ของตััวแบบ SARIMA(1, 1, 1)(1, 0, 1)12

	ขั้้ �นตอนที่่� 2 การประมาณค่าพารามิเตอร์์ (Parameter 
Estimation) ทดสอบ model ที่่�เลืือกมาได้้ 
	 2.1 โดยการคลิิกเมนู Analyze > Forecasting > Create 
models ดัง (ภาพที่่� 4A)
	 2.2 Variable tab (ภาพที่่� 4B)
	 	 ในช่อง Dependent variable ให้้เลืือกตััวแปรที่่�
ต้้องการวิิเคราะห์์ เช่่น Food Poisoning (case) 
    	 	   ในช่อง Independent variable ให้้เลืือกตััวแปรที่่�

ต้้องการวิิเคราะห์์ เช่่น MONTH, period 12_MONTH_1
	 	 ในช่อง Method ให้้เลืือกวิิธีีการวิิเคราะห์์ที่่�จะใช้้เป็็น 
ARIMA 
	 	 ใน ARIMA Criteria dialog box ช่อง ARIMA order 
ให้้นำำ�ตััวแบบที่่�คิิดว่าเหมาะสมมาใส่่ สำำ�หรัับตััวอย่่างนี้้�ได้้ตััวแบบ ARIMA 
(1, 1, 1) x (1, 0, 1)12

	 2.3 Model tab (ภาพที่่� 4C)
	 	 จะได้้  p=1, d=1, q=1  และ  P=1, D=0, Q=1  
	 2.4 Statistics tab (ภาพที่่� 4D)
	 	 เลืือก fit statistics ที่่ �สนใจ โดยทั่่�วไปแนะนำำ�ให้้
เลืือก  Display fit measures, Ljung Box statistic ค่่าสถิติิ R square, 
RMSE, MAPE, MAE ในช่่อง Statistics for individual models ให้้
เลืือก Parameter estimates 
	 2.5 Plots tab (ภาพที่่� 4E)
	 	 ไม่่ต้้องดููกราฟ   ACF, PACF อี กเพราะรู้้�ค่่าลำำ�ดับ
ของ  p d q, P D Q แล้้ว
	 Click OK เพื่่�อให้้ทำำ�การวิิเคราะห์์ ได้้ค่่าสถิติิความคลาด
เคลื่่�อน R square, RMSE, MAPE, MAE, ค่่า Ljung Box Q test, 
p-value >0.05 และตาราง ARIMA Models Parameters ดั ัง 
(ภาพที่่� 4F)

	ขั้้ �นตอนที่่� 3 การตรวจสอบความเหมาะสมของตััวแบบ 
(Diagnostic Checking) ในการพยากรณ์์ การทำำ�การพยากรณ์์ค่่าที่่�
ตััดออกไป เรีียกว่่า วิธีี backcasting มีขั้้�นตอนดังนี้้� นำำ�ไฟล์์ Data file.
sav  ซึ่�งมีีข้้อมููลตััวแปร case ตั้้�งแต่่เดืือนมกราคม 2546 ถึึง ธันวาคม 
2562 จำ ำ�นวน  204 ค่ ่า เพิ่่�มตััวแปรใหม่่ชื่่�อว่่า backcast โดยตััดช่่วง
ปีี 2562 ออก มีข้้อมููลตั้้�งแต่่เดืือนมกราคม 2546 ถึึง ธันวาคม 2561 
จำำ�นวน 192 ค่่า และหาค่่าพยากรณ์์ ทำำ�นายช่่วงปีี 2562 จำำ�นวน 12 
ค่่า
	 3.1 เราต้้องกำำ�หนดให้้โปรแกรมรู้้�จักข้้อมููลอนุุกรมเวลาก่่อนด้้วย
การคลิิกที่่�เมนู Data > Define dates > เลืือกรููปแบบเวลาที่่�ตรงกัับข้้อมููล
ของเรา (เช่่น ถ้าเป็็นข้้อมููลรายเดือืน ก็คืือ Years, months) และระบุเุวลา
ที่่�เริ่่�มต้น เช่่น Year = 2546, month = 1 click OK จากนั้้�นจะสัังเกตเห็็น
ว่่ามีีตััวแปรใหม่่เกิิดขึ้้�นในข้้อมููลของเรา คือ (YEAR_, MONTH_, DATE_)  
เมื่่�อเชื่่�อมวันเดืือนใหม่่แล้้ว ให้้ run อีกครั้้�งใช้้ ค่า  p d q  P D Q เดิิม 
p=1, d=1, q=1  และ  P=1, D=0, Q=1 โดยไม่่ต้้องดููค่่าความคลาด
เคลื่่�อนอีก ทำ ำ�การพยากรณ์์ตััวแบบที่่�เลืือกมาได้้ สำ ำ�หรัับขั้้�นตอนที่่� 3.2 
– 3.5 สามารถดูการลงรายละเอีียดในแต่่ละขั้้�นตอนได้้จากภาพที่่� 4 เพื่่�อ
ความเข้้าใจมากยิ่่�งขึ้้�น
	 3.2 โดยการคลิิกเมนู Analyze > Forecasting > Create models 
	 3.3  Variable tab 
	 	 ในช่อง Dependent variable ให้้เลืือกตััวแปรที่่�
ต้้องการวิิเคราะห์์ เช่่น backcast 	
	 	 ในช่อง Independent variable ให้้เลืือกตััวแปรที่่�
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ต้้องการวิิเคราะห์์ เช่่น MONTH, period 12_MONTH_1
	 	 ในช่อง Method ให้้เลืือกวิิธีีการวิิเคราะห์์ที่่�จะใช้้เป็็น ARIMA 
	 	 ใน ARIMA Criteria dialog box ช่อง ARIMA order 
ให้้นำำ�ตััวแบบที่่�คิิดว่าเหมาะสมมาใส่่ สำำ�หรัับตััวอย่่างนี้้�ได้้ตััวแบบ ARIMA 
(1, 1, 1) x (1, 0, 1)12

	 3.4  Model tab จะได้้  p=1,d=1, q=1  และ  P=1,D=0, Q=1  
	 3.5   Statistics tab เลืือก fit statistics ที่่ �สนใจ โดยทั่่�วไป
แนะนำำ�ให้้เลืือก Display fit measures, Ljung Box statistic ค่าสถิติิ R 
square, RMSE, MAPE, MAE 
	 3.6  Plots tab ในช่อง Plots for individual Models ให้้เลืือก 
Series จากนั้้�นเลืือก Observed values, Forecasts และ Fit values 
	 3.7  Save tab อาจเลืือกให้้แสดง Predicted ถ้าต้้องการดููค่่า
พยากรณ์์โดยยัังไม่่ต้้องการให้้บัันทึึกไว้้ใน data file 
	 3.8  Options tab ใช้้ตอนที่่�เราได้้ตััวแบบที่่�คิิดว่าดีีที่่�สุุดแล้้วและ
ต้้องการให้้พยากรณ์์ค่่าในอนาคต โดยให้้เลืือกคลิิก First case after end 
of estimation period through a specified date และระบุุช่่วงเวลา
ที่่�ต้้องการให้้พยากรณ์์ไปถึึง เช่่น Year = 2562, Month = 12 Click OK 
เพื่่�อให้้ทำำ�การพยากรณ์์ ได้้ผลลััพธ์์ดััง (ภาพที่่� 5)

ขั้้�นตอนที่่� 4  การพยากรณ์์ (Forecasting)  หลัังจากการทำำ� back-
casting เพื่่�อตรวจสอบการพยากรณ์์ เมื่่�อไปดูที่่� หน้้าจอ Data file จะพบ
ว่่ามีีตััวแปรใหม่่เกิิดขึ้้�น คือ 
	 Predicted_... คือ ค่าที่่�ได้้จากการพยากรณ์์ ซึ่�งจะประกอบด้้วย 
1. ค่าพยากรณ์์ของข้้อมููล record แรกจนถึึงช่่วงเวลาที่่�เรามีข้ี้อมููลอัันสุดท้าย 
(Fit values) เช่่น ข้้อมููลปีี พ.ศ. 2546 - 2561

2. ค่าพยากรณ์์เท่่าที่่�เราต้้องการให้้พยากรณ์์ทำำ�นายไปข้้างหน้้า (Forecasts) 
เช่่น ข้้อมููลปีี พ.ศ.2562
	 NResidual_... คื อ ค่าความคลาดเคลื่่�อน  (Error) หรืือ (ข้้อมููล
จริิง – ค่าทำำ�นาย) สำำ�หรัับโปรแกรม IBM SPSS ไม่่สามารถหาค่่า ความคลาด
เคลื่่�อน ในการทำำ� backcasting ได้้ในส่วนที่่�ทำำ�นายไปข้้างหน้้าต้้องคำำ�นวณ
จากสููตร
	 ผลการพยากรณ์์จำำ�นวนผู้้�ป่วยโรคอาหารเป็็นพิษ (food poison-
ing) จังหวััดกรุุงเทพมหานคร ด้้วยโปรแกรม IBM SPSS หาตััวแบบที่่�เหมาะ
สมที่่�สุุดด้้วยวิิธีีบ็็อกซ์์เจนกินส์์ คือ ARIMA (1, 1, 1) x (1, 0, 1)12  ค่าสถิติิ 
Ljung-Box Q test  มีค่่า p value > 0.05 ไม่่มีีนััยสำำ�คัญทางสถิติิ และได้้
พยากรณ์์ไปข้้างหน้้าตั้้�งแต่่เดืือนมกราคมถึึงเดืือนธันวาคม พ.ศ. 2562 ผล
จากการเปรียบเทีียบค่าข้้อมููลจริิงกัับค่าพยากรณ์์ด้้วย backcasting ได้้ค่่า
คลาดเคลื่่�อนสัมบูรณ์์เฉลี่่�ย (MAE) เท่่ากัับ 56.94, ค่าเปอร์์เซ็็นต์ผิิดพลาด
เฉลี่่�ยสััมบูรณ์์ (MAPE) เท่่ากัับ 18.18 นำำ�ค่าประมาณของพารามิิเตอร์์ที่่�ได้้
จากตาราง Output ภาพที่่� 4F มาแทนค่าลงในตััวแบบ ARIMA (1, 1, 1) x 
(1, 0, 1)12 จะได้้เป็็นสมการการพยากรณ์์ที่่�สามารถใช้้ในการพยากรณ์์ค่่าใน
อนาคตได้้ต่่อไป เมื่่�อได้้ค่่าพยากรณ์์ล่่วงหน้้าแล้้ว สามารถใช้้สร้างแนวทางใน
การป้้องกัันการเกิิดโรคดัังกล่่าวได้้ ด้้วยกรมควบคุมโรค ขอให้้ประชาชนใช้้
มาตรการ “สุุก ร้อน สะอาด” โดยรัับประทานอาหารปรุงสุุกใหม่่ด้้วยความ
ร้้อน ไม่่มีีแมลงวัันตอม ล้างมืือด้้วยน้ำำ��และสบู่่�บ่อยๆ รักษาสุุขอนามััยจะช่่วย
ป้้องกัันโรคอาหารเป็็นพิษได้้
	 การวิิเคราะห์์ข้้อมููลอนุุกรมเวลา อาจมีีตััวแบบที่่�เหมาะสมมากกว่่า 
1 ตััวแบบ ควรเลือืกตััวแบบ เช่่น ตััวแบบที่่�มีีจำำ�นวนพารามิเิตอร์์น้้อยกว่่าหรืือ
ตััวแบบที่่�สามารถนำำ�มาใช้้ในการพยากรณ์์ได้้ง่่ายกว่่า และมีีค่่าความคลาด
เคลื่่�อน (error) น้อยกว่่าด้้วย

ตารางที่่� 2 แสดงการเปรียบเทีียบการตรวจสอบตััวแบบจากโปรแกรม IBM SPSS

SARIMA  model R square RMSE MAE MAPE Ljung Box Q ผลการพิจารณา

ARIMA (1, 1, 1) x (1, 0, 1)12   0.582 80.63 56.94 18.18 0.145 เป็็น model ที่่�ดีีที่่�สุุด

ARIMA (1, 1, 1) x (1, 1, 1)12   0.573 82.11 59.49 19.05 0.121 Error สูงกว่่า

ARIMA (1, 1, 0) x (1, 1, 0)12   0.314 103.42 73.91 22.83 0.000 Error สูงกว่่า

ARIMA (1, 1, 1) x (1, 0, 0)12  0.510 87.09 61.34 19.77 0.333 Error สูงกว่่า

Expert modeler 
จากโปรแกรมค�ำนวณ

0.599 77.95 56.60 17.56 0.000
ค่่า Ljung-Box test p 

value < 0.05

ที่่�มา: วรีียา วงศ์์พานิิช
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ภาพที่่� 1 การเตรีียมข้้อมููล
ที่่�มา: วรีียา วงศ์์พานิิช

1A 1B

2A

2B

2C

ภาพที่่� 2 แสดงการแปลงข้้อมููลอนุุกรมเวลา
ที่่�มา: วรีียา วงศ์์พานิิช
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2D 2E

ภาพที่่� 3A กราฟ ACF และ PACF ของอนุุกรมเวลาของการป่วยด้วยโรคอาหารเป็็นพิษ 
ที่่�มา: วรีียา วงศ์์พานิิช

ภาพที่่� 3B  กราฟ ACF และ PACF ของอนุุกรมเวลาของการป่วยด้วยโรคอาหารเป็็นพิษ
เมื่่�อแปลงข้้อมููลด้้วยการหาผลต่่างแนวโน้้มลำำ�ดัับที่่� 1

ที่่�มา: วรีียา วงศ์์พานิิช
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ภาพที่่� 3C กราฟ ACF และ PACF ของความคลาดเคลื่่�อนจากการพยากรณ์์โดยวิิธีีบ็็อกซ์์เจนกินส์  ที่่�มีีตััวแบบ SARIMA(1,1,1)(1,0,1)12

ที่่�มา: วรีียา วงศ์์พานิิช

4A

4B

4C

ภาพที่่� 4 แสดงการทดสอบ model ที่่�เลืือกมาได้้
ที่่�มา: วรีียา วงศ์์พานิิช
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4D 4E

4F

ภาพที่ 5 แสดงผลลัพธ์การพยากรณ์ย้อนหลัง backcasting
ที่่�มา: วรีียา วงศ์์พานิิช
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	 SPSS มีคำำ�สั่่�ง Expert Modeler ที่่�ช่่วยให้้เราเลืือกตััวแบบได้้
สะดวกขึ้้�น โดยโปรแกรมจะเลืือกตััวแบบที่่�เหมาะสมกับข้้อมููลที่่�สุุดมาให้้ 
อย่่างไรก็็ตามผู้้�พยากรณ์์ควรนำำ�ตััวแบบที่่�ได้้มาทดสอบเปรียบเทีียบกับ
ตััวแบบอื่่�นๆ (ที่่�มีีค่่า fit statistics ใกล้้เคีียงกััน) โดยการทำำ� backcasting 
ตรวจสอบความเหมาะสมในการพยากรณ์์ด้้วย เนื่่�องจากโปรแกรมจะให้้ตััว
แบบที่่�เหมาะสมที่่�สุุดอาจจะไม่่ใช่่ตััวแบบที่่�พยากรณ์์ไปข้้างหน้้าได้้ดีีที่่�สุุด ควร
เลืือกตััวแบบด้้วยตััวเอง ไม่่ควรใช้้คำำ�สั่่�ง Expert Modeler โดยไม่่ตรวจสอบ
ค่่าสถิติิเพราะจะได้้ข้้อมููลที่่�ผิิดเพี้้�ยน มีค่่า error เยอะมาก สำำ�หรัับข้้อมููลชุุด
นี้้� Expert Modeler ให้้ค่่า Ljung-Box Q test p value < 0.05 ถึึงแม้้ว่่า
ค่่าความคลาดเคลื่่�อน (error) จะน้้อยกว่่าก็็ตาม

สรุป
	 การพยากรณ์์ข้้อมููลอนุุกรมเวลาทางการแพทย์์ด้้วยวิิธีีบ็็อกซ์์
เจนกินส์์ตััวแบบอารีีมามีีเงื่่�อนไขว่าจะต้้องใช้้ในการวิิเคราะห์์ข้้อมููลอนุุกรม
เวลาที่่�มีีคุุณสมบัติิคงที่่�เท่่านั้้�น และมีีฤดููกาลได้้แต่่ต้้องมีีคุุณสมบัติิคงที่่�เช่่น
เดีียวกััน  ในกรณีีที่่�ข้้อมููลอนุุกรมเวลาที่่�ใช้้ในการวิิเคราะห์์มีีคุุณสมบััติิไม่่
คงที่่� จะต้้องทำำ�การแปลงข้้อมููลอนุุกรมเวลา จากการพิิจารณาว่่าข้้อมููล
อนุุกรมเวลานั้้�นว่ามีีค่่าเฉลี่่�ยไม่่คงที่่� (มีีแนวโน้้มเป็็นองค์์ประกอบ) หรืือ
ความแปรปรวนของอนุุกรมเวลาไม่่คงที่่� วิ ธีีการแปลงข้้อมููลก็็จะแตกต่่าง
กััน  โดยการหาผลต่่างสำำ�หรัับข้้อมููลอนุุกรมเวลาที่่�มีีค่่าเฉลี่่�ยไม่่คงที่่� 
และการใช้้ฟัังก์์ชัันการแปลงข้้อมููลสำำ�หรัับความแปรปรวนไม่่คงที่่� 
ก่่อนที่่�จะนำำ�ข้้อมููลไปใช้้สร้้างตััวแบบอารีีมา และในปััจจุุบัันได้้มีีการ
พััฒนาทางด้้านโปรแกรมสำำ�เร็็จรููปสำำ�หรัับการพยากรณ์์เชิิงปริมาณ
หลากหลายโปรแกรมที่่�สร้้างความสะดวก รวดเร็็ว และถููกต้้องแม่่นยำำ� 
แสดงค่่าวััดความคลาดเคลื่่�อนไว้้เพื่่�อให้้ผู้้�พยากรณ์์ใช้้ความรู้้�ในการ
ตััดสินใจเลืือกวิิธีีพยากรณ์์ตามหลัักเกณฑ์์ที่่�กำำ�หนดไว้้ โดยเลืือกวิิธีี
การพยากรณ์์ที่่�เหมาะสมกับลักษณะข้้อมููลให้้ค่่าความคลาดเคลื่่�อน
สำำ�หรัับการพยากรณ์์ต่ำำ��ที่่� สุุด  การพยากรณ์์ด้้วยวิิธีีบ็็อกซ์์เจนกินส์์
ตััวแบบอารีีมา มี  4 ขั้้ �นตอนโดยใช้้โปรแกรม  IBM SPSS เป็็นทาง
เลืือกหน่ึ่�งที่่�ให้้ความแม่่นยำำ�สูงสำำ�หรัับผู้้�พยากรณ์์ที่่�ขาดประสบการณ์์
สามารถนำำ�มาพยากรณ์์สำำ�หรัับข้้อมููลอนุุกรมเวลาที่่�มีีความผันแปรของ

แนวโน้้ม วัฏจัักร และฤดููกาลที่่�มีีความไม่่ชััดเจน สร้้างตััวแบบในการ
พยากรณ์์ที่่�เหมาะสมได้้
	 การรายงานผลการวิิเคราะห์์ข้้อมููลอนุุกรมเวลานอกจาก
การระบุุตััวแบบและค่่าความคลาดเคลื่่�อนต่่างๆแล้้ว สำำ�หรัับการเขีียน
รายงานฉบัับสมบูรณ์์ให้้แสดงสมการการพยากรณ์์ของตััวแบบ ซึ่ �ง
ประกอบด้้วยค่่า Coefficient ขององค์์ประกอบต่่างๆ ได้้แก่่ AR, MA, 
SAR, SMA แต่่ละตััว และนััยสำำ�คัญทางสถิติิด้้วย ซึ่ �งค่่าต่่างๆ เหล่่า
นี้้�จะแสดงอยู่่�ตาราง ARIMA Model Parameters ของ IBM SPSS 
Output สม การการพยากรณ์์ที่่�ได้้มาสำำ�หรัับข้้อมููลชุุดนั้้�นๆ ส ามารถ
นำำ�มาใช้้พยากรณ์์ข้้อมููลอนุุกรมเวลาในอนาคตได้้ต่่อไป

กิิตติิกรรมประกาศ
	 ขอขอบคุุณสำำ�นักโรคระบาด  กรมควบคุุมโรคที่่�ให้้ความ
อนุุเคราะห์์ข้้อมููลอนุุกรมเวลาจำำ�นวนผู้้�ป่วยรายเดืือนโรคอาหารเป็็นพิษ 
(food poisoning)ในการนำำ�มาเป็็นตััวอย่่างการวิิเคราะห์์ข้้อมููลสถิติิ
พยากรณ์์วิิธีีบ็็อกซ์์เจนกินส์์ด้้วยตััวแบบอารีีมาสำำ�หรัับบทความนี้้�
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